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Using Pl Data for Predictive
Analytics

Michael Eschenbruch
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* About Genesis Energy
« Our journey to date
* The PI System and how we’re using it

 Predictive analytics and some successful
examples

 Where to from here
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Introduction to New Zealand

and my accent...

* Small country in the southwest Pacific Ocean

* From a power generation perspective
* ~43,000 GWh annually
+ ~9000 MW installed capacity

+ 2018 annual primary energy supply equivalent to 3% days for
USA

Accent
+ ‘e’ is usually elongated and sounds like ¥’
+ ‘yes’ sounds like ‘yis’
+ ‘Beth’ sounds like ‘Bith’

* ‘i"is usually pronounced like ‘U’
» ‘fish and chips’ sounds like ‘fush and chups’

* lazy use of ‘L’ after a vowel
*  ‘milk’ sounds like ‘miuk’

& OSlsoft.
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About Genesis Energy

An integrated energy management company, New Zealand’s largest energy retailer generating electricity from coal, gas, hydro and wind and an interest in an oil and gas field.

&8 500000+

customers

é 25% electricity market share

~ WAIKAREMOANA

Peak C MW
i - . 38% gas market share
TONGARIRO KUPE © 19% LPG market share
"E Pesk Capacity/ MW
HAU NUI
5 Pask Capacity/ MW
PURPOSE:
e AR o Bxisting LPG depots reimagine energy to put
: 1 90 ey ot control in our customers’ hands
v Peak Capacity/ MW
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Genesis Journey

» 2017 — workshop to identify what data we have, how we
can be more effective with, how to assist with decision
making, identified the potential.

« 2017 and 2018 — testing in-house data science capability

» 2018 — developed generation specific data warehouse
project — Pl Integrator was a key

* End of 2018 — investigate external software vs internal
data science capability wain mape-ar2

+ 2019 — committed to internal development/deployment,
~800 models created

¥
S0 & 60 65
L L L
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005 o005 10
1 1 I

T T T T T
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T T T T T
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* What resources we’ve relied on
* Open source software test mape=0.033
* Pl Integrator, Microsoft Azure Datawarehouse

« Data scientists, data architects/engineers, generation =
engineers

00 02 04 06 08 10
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How did the Pl System fit in?

Pl Server Asset Framework (AF) and Pl Integrator

Data warehouse project — combining all high use
generation related data into one location

Pl Historian a key dataset, had existing extraction
method;

 resolution of 10 or 30 min data only

* managed by consultant

* have to request what tag, what type of calculation; average,
total, point in time etc and a cost per request

Pl Integrator was available and meant we could manage
internally

Didn’t have functioning Pl Server Asset Framework so
this was required as part of project

OSlsoft.
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Pl Server Asset Framework

Pl Server Asset Framework is necessary for Pl Integrator
— we hadn’t deployed AF

Duplicated existing CMMS hierarchy to an AF hierarchy

OSlsoft Partner managed deployment and aligning 70%
of tags into hierarchy

Pl Server Asset Framework also has a lot of potential
that we are not using at this stage

OSlsoft.

PlWorld sanrrancisco 2020

Elements

(B Eements
Ei- (3 STATIONS

- (9 HUNTLY

3 HLYDL: UNIT 1
G A: UNIT TRANSMISSION AND DISTRIBUTION
~ (3 B: POWER STATION ELECTRICAL SYSTEM
9 C: INSTRUMENTATION AND CONTROL EQUIPMENT SYSTEMS
& E: FUEL SUPPLY AND ASH AND DUST DISPOSAL SYSTEM
~ (J G: WATER SUPPLY AND DISCHARGE SYSTEM
3 H:BOILER SYSTEM
G L: STEAM WATER AND GAS CYCLES SYSTEM
~ (3 M: MAIN MACHINES SYSTEM
(3 MaA: STEAM TURBINE PLANT INCLUDING CONDENSER
& MK: GENERATOR PLANT
» (§ MP: COMMON INSTALLATIONS FOR MAIN MACHINES
(3§ MV: LUB. OIL SUPPLY - MAIN MACHINE
& MX: CONTROL FLUID SUPPLY
+ [ MY: CONTROL REGULATING AND PROTECTION EQUIPMENT
9 P: COOLING WATER PLANT
& Q: UNITISED STATION ALX SYSTEMS (EG AIRCHILLED H20 ETC)
~ (3 St ANCILLARY SYSTEMS
9 U: STRUCTURES
9 2: MAINTENANCE LABORATORY AND OFFICE EQUIPMENT
~ () HLYOZ: UNIT 2
(9 HLYD4: UNIT 4
3 HLYDS: UNIT 5
~ (3 HLYOS: UNIT &
(9 HLYCS: COMMON SERVICES

E-E-E-E-E-E

(3 REN: RENEWABLE ENERGY

~ ) RENC: RENEWABLE ENERGY COMMON
[ TEK : TEKAPO POWER SCHEME
(3 TPS : TONGARIRO POWER SCHEME

~ () WAI: WAIRARAPA GENERATION FACILITIES
(F WPS : WAIKAREMOANA POWER SCHEME

], Blement Searches

HLYO1: UNIT 1
General Child Elements  Attributes ports  Analyses  Version
Exduded attributes are hidden.

Filter
2| t @/ %R Name | Value
§ ¥ Actual frequency window famw
% ATTUAL MW DEVIATION DETECTED ALARM False
7 Auxiliary MW correction {unit auxdliary MW + station auxliary MW port... |0 MW
7 DISPATCH ON ALITO MODE False
< Dispatched nett MW setpaint agc load setpoint oMW
7 Genco disptach FIR. (from transpower) omMw
&7 Genco disptach SIR (from transpower) omMw
E] =1 KKS CODE HLYO1
¥ MW due to frequency control omMw
7 MV SETPOINT DEVIATION DETECTED ALARM False
7 Unit gross MW setpaint input 50 MW
< Unit gross MW setpaint output oMW
] & Unit MVAR output 0MVAR
&F Unit MW Nett 0
| &F Unit MW output omw
& UnitMW 5P oMW

#PIWorld ©2020 OSlsoft, LLC



Pl Integrator

« Utilises AF hierarchy

* Pullin necessary tags ememeoes |
+ Define interval and data context (eg average, min, max) . : :_ =
* Writes data to data warehouse i :t
 Data can be scheduled or single load = ; é
» For us writes to Azure Datawarehouse but are other = % * "
options (Amazon, Microsoft, Oracle, flat file) = z = =
OStsof
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Select Data > Modify View > Publish

) Source Assets

v (7) Search Shape

EETE GEPIAF

L

Database

Genesis Assets

[+]
4

D Assets

4 [ STATIONS
» (D) HUNTLY
4 [2) REN: RENEWABLE ENERGY
» [2) RENC: RENEWABLE ENERGY COMMON
» () TEK : TEKAPO POWER SCHEME
» [2TPS: TONGARIRO POWER SCHEME
» [5) WAL WAIRARAPA GENERATION FACILITIES
4 [ WPS : WAIKAREMOANA POWER SCHEME
» (2 KTW : KAITAWA POWER STATION
» () PRI: PIRIPAUA POWER STATION
4 [ TUI: TUAI POWER STATION
) TUIZFQ : HYDROLOGY
» (2 TUIDT : UNIT 1
» (2 TUIDZ : UNIT2
b () TUID3 : UNIT3

b () TUIS : TUAI STATION SERVICES

Attributes | Filter

< ][]

O Select Al

15 MINUTE WARNING OF FREQUENCY CONTROL
# DRAINAGE SUMP PUMP 2 WATER LEVEL HIGH -START
 FLOOD PROTECTION DC P/S

# Frequency contrcl MW bias

 FREQUENCY CONTROL ON

 Genco counter #1

4 Genco counter #2

# Genco kaitawa FIR

# Genco kaitawa kv

# Genco kaitawa MVAR

# Genco kaitawa MW

# Genco kaitawa rdn

# Genco kaitawa rup

# Genco kaitawa SIR

(-2 - - - - - - - - - -

»

L Azset Shape

4 [ WPS : WAIKAREMOANA POWER SCHEME
4 [ KTW : KAITAWA POWER STATION
# KTW Cooling Water Temperature
#F KTW Cocling Water Temperature 24 hour average
F KTW Cocling Water Temperature 7 day average
4 [7) PRI: PIRIPAUA POWER STATION
# Tuai Ambient Air Temperature 24 hour moving average
#F Tuai Ambient Air Temperature 7 day maoving average
P Tuai Rainfall 24 hour average
# Tuai Rainfall today
4 (2 TUI: TUAI POWER STATION
4 @ TUIZFQ: HYDROLOGY
 Kataws Lake Level
#F Tuai Surge Chamber Level
# Whakamarino Lake Level
4 @TUI0T :UNITT
 Turbine flow
& Unit MVA
# Unit MVAR outpat
F Unit MW cutput
 Unit total current
4 Unit voltage
# Unit winter kennedy pressure
4 Unit winter kennedy turbine flow
4 [ TUIO1/B : ELECTRICAL SYSTEMS
4 () TUIO1/BAT : TRANSFORMER
# T1 ail H2 level
F T1 ail h20 level
#F T1 top cil temperature
4 T1 winding temperature
4 e TUID1/L : WATER STORAGE INTAKE AND PENSTOCKS
4 @ TUID1/LPC : PENSTOCK SYSTEM
P Penstock pressure
4 @) TUIO1/ME : TURBINE PLANT
4 e TUIDT/MEA : TURBINE AND ASSOCIATED EQUIPMENT
4 @ TUID1/MEASD : BEARING ASSEMBLIES
#F Bearings oil temp

4 Turbine bearing temp

a2
X
S x
&, x
&, x
£ x
S x
&, x
&, x
£ x
£ x
&, x
%
S x
&, x
&, x
X
SR
&, x
&, x
X
SR
&, x
&, x
X
S x
&, x
&, x
X
S x
&, x
&, x
£ x
S x
&, x
&, x
£ x
.

 Matches
Found 1 Match

» ) WPS : WAIKAREMOANA POWER SCHEME



Select Data > Modify View > Publish

4 Add Column T Edit Row Filters £2 Edit Value Mode Start Time End Time
01 cohurms 0 Fiaw Fiters nterpolzted Values
|| Every 30 miruses 1/01/16 12:00:00 AM Eﬂ ‘ .
TimeStamp TUIOT_Unit_ MW TUIOT_Unit MVA  TUIOT_Unit_MWAr TUI0T_Unit_Current  TUID1_Unit_Voltage  TUWI01_Unif_WinteriKennedyPressure TUIRT_Unit_Winterkennedy TurbineFlow TUIDT_Unit_TurbineFlow TUI01_Penslock_Pressure TUID1_WicketGates_Pasition
1/01/2016 12:00:00 AM H 110936 1124737 10.181 H 32500
17012016 12:30:00 AM 110,988 1126265 ‘l[HE’I i ‘328[“]
1/01/2016 1:00:00 AM .10 986 | 126.083 10.182 .19.550 32800
1/01/2016 1:30:00 AM 10986 128.675 10.182 19.556 32600
1/01/2018 2:00:00 AM 10886 127.897 10.183 19.541 32700
17012016 2-:30:00 AM 10986 125.499 10183 19,547 32 600
1/01/2016 3:00:00 AM 10986 126,948 9815 10.184 19.552 32600
1/01/2018 3:30:00 AM 10936 127722 9.883 10.184 19.552 32.800
1/01/2018 4:00:00 AM 10886 127.15 a.881 10.185 19.559 32500
17012016 4:30:00 AM 10986 127 626 9897 10185 19554 32.400
1/01/2018 5:00:00 AM 10,936 126.103 9.908 10.186 19.557 32300
1/01/2018 5:30:00 AM 10936 129.189 9848 10.186 19.557 32500
1/01/2018 6:00:00 AM 10.886 128.995 9.858 10.187 19.551 32600
170172016 6:30:00 AM 10954 128 931 9827 10187 19,554 32 800
1/01/2018 7-00:00 AM 10918 126924 9947 10.188 19.566 33200
1/01/2018 7-30:00 AM 10915 127891 9.935 10.188 19.566 33433
1/01/2016 5:00:00 AM 10912 128.818 9.804 10.189 19.542 34200
170172016 &30:00 AM 10308 125 424 9869 10189 19,552 32 .400
1/01/2018 9:00:00 AM 11.001 126.048 9847 10.180 19.556 31.800
1/01/2018 9:30:00 AM 11.015 125.098 9.847 10.180 19.575 32.000
1/01/2016 10:00:00 AM 1132 125.630 9.854 10.191 19.556 32100
1/01/2016 10:30:00 AM 1131 128 405 9914 10.191 19.576 32100
1/01/2016 11:00:00 AM 1129 125.648 9878 10.182 19.543 32.059
1/01/2016 11:30:00 AM 11.050 125771 9.808 10.182 19.557 32300
10172016 12:00:00 PM  {7.979 11.060 129.486 9.869 10.193 19.547 32.400
1/01/2016 12:30:00 PM | 8.053 11.052 128.008 9820 10.193 19.554 31800
1/01/2016 1:00:00 PM 7.972 11.142 128.222 9.825 10.184 19.552 32100
1/01/2016 1:30:00 PM 8.005 1135 129.390 9.887 10.194 19.555 32100
1/01/2016 2:00:00 PM 8 11128 126232 9898 10194 19547 32.000
1/01/2016 2:30:00 PM 7.997 1121 126.076 9.813 10.195 19.571 32.000
1/01/2018 3:00:00 PM 7.958 11.233 125.763 9.864 10.185 19.547 31.700
1/01/2016 3:30:00 PM 7.979 11.234 129.058 9878 10.196 19.561 32100
17012016 4:00:00 PM 7884 11234 128606 9896 10196 19,550 31900
1/01/2016 4:30:00 PM 7.969 11.235 129.956 9832 10.197 19.564 32500
1/01/2016 5:00:00 PM 8 11.236 128523 9838 10.197 19.566 32800
1/01/2016 5:30:00 PM am 11.236 126.348 a8 10.198 19.551 32700
1/01/2016 6:00:00 PM 796 11237 129277 9863 10198 19570 32.800
1/01/2016 6:30:00 PM 7.965 11.233 127.422 9.802 10.199 19.574 32.800

OSlsoft.
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Object Explorer

Connect~ &3 &4

)

E= pi.Dispatch_Compliance_Reporting -
= pi.HLY_CoalAndAshModelling

pi.HLY_Fuels
pi.HLY_RankineHeatrate
pi.HLY_RankineMuodelling
pi.HLY_RiverHeatingModelling
pi. HLY_WEATHER_STATION
pi.HLYRankine_Muodelling

pi. KTW_Modelling
pi.PRI_Modelling
pi.RIVERTEMPERATUREMODELLING
pi.RPO_Brushgeared
pi.RPO_Modelling

pi. TEK_Medelling

pi. TKA_Modelling

pi. TKU_Modelling

pi. TKU_Modelling_Test

pi. TKUO1_Meodes

£ pi.TUI_Modelling

= 3 Celumns

=] Id (bigint, not null)

| TimeStamp (datetime, null)

TUIDT_Unit_MW (float, null)

TUID_Unit_MVA (real, null)

=| TUIDT_Unit_MVAr (float, null)

TUIDT_Unit_Current (real, null)
TUIDT_Unit_Voltage (real, null)

=| TUIDT_Unit_WinterKennedyPressure (real, null)
TUIDT_Unit_WinterKennedyTurbineFlow (real, null
TUIDT_Unit_TurbineFlow (real, null)

=| TUID1_Penstock_Pressure (real, null)
TUIDT_WicketGates_Position (real, null)
TUIOT_TurbineBearing_Temperature (real, null)

=| TUIO1_GeneratorBearing_Temperature (real, null)
TUIOT_ThrustBearing_Temperature (real, null)
TUIOT_BearingsQil_Temperature (real, null}

=| TUID1_TurbineBearing_XVibraticn (real, null)
TUIOT_TurbineBearing_YVibration (real, null)
TUIOT_GeneratorBearing_XVibration (real, null)

=| TUID1_GeneratorBearing_YVibration (real, null)
TUID1_TransformerQil_H2Level (real, null)
TUID1_TransformerQil_H20Level (real, null)
TUIOT_TransformerQil_TopQilTemperature (real, r
TUIOT_TransformerWinding_Temperature (real, nu
TUIOT_GeneratorStator_Temperaturel (real, null)
=| TUID1_GeneratorStator_Temperature2 (real, null)

el e e e

Q1 Query'.sal - ge..energy.co.nz 257" -+ >« |

100 %

J*****% script for SelectTopNRows command from SSMS
SELECT TOP (1leea) [Id]

, [TimeStamp]

,[TUT@L_Unit_MW]

,[TUT@L_Unit_MVA]

,[TUI®L Unit_MvAr]
,[TUI@1l_Unit_Current]
,[TUI81_Unit_Voltage]
,[TUI@1l_Unit_WinterKennedyPressure]
,[TuTel_Unit_WinterkKennedyTurbineFlow]
,[TUI@1_Unit_TurbineFlow]
,[TuI@l_Penstock_Pressure]
,[TUI@l_WicketGates_Position]
,[TuT@l_TurbineBearing_Temperature]
,[TUI@l_GeneratorBearing_Temperature]
,[TuI@l_ThrustBearing_Temperature]
,[TuI@l_Bearings0il_Temperature]
,[Tuz@l_TurbineBearing_Xvibration]
,[TUI@l_TurbineBearing_YVibration]
,[TUI@1l_GeneratorBearing_Xvibration]
,[TuI@l_generatorBearing_YVibration]
,[Tuzel_Transformer0oil H2Level]
,[TUIel_Transformer0il_H20Level]
,[TuIe1l_Transformer0il_TopOilTemperature]
,[TuIel_TransformerWinding_Temperature]

,[TUI@1l_GeneratorStater Temperaturel]

[ Resuts |i§ Messages

O 00 o~ o W R =

Id

0~ N b W RS

TimeStamp

2016-01-01 00:00:00.000
2016-01-01 00:30:00.000
2016-01-01 01:00:00.000
2016-01-01 01:30:00.000
2016-01-01 02:00:00.000
2016-01-01 02:30:00.000
2016-01-01 03:00:00.000
2016-01-01 03:30:00.000
2016-01-01 04:00:00.000
2016-01-01 04:30:00.000
2016-01-01 05:00:00.000
2016-01-01 05:30:00.000
2016-01-01 06:00:00.000
2016-01-01 06:30:00.000
2016-01-01 07:00:00.000
2016-01-01 07:30:00.000
2016-01-01 08:00:00.000
2016-01-01 08:30:00.000

TUIDT_Unit_MVY

8006667137146

8.013352508544592
7.98553091964722
7.98651266058022
7.95331665035063
7.55444532354405
7.98563861846924
8.06240653991639
7.97382164001465
7.98319303512573
7.96353451343267
7.93758535385132
7.93740510940552
2.00050735473633
7.94243282040161
8.02752453765869
8.11566896057129
8.01126670837402

TUIDT_Unit_MVA
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL

EREEEE S

TUI0A_Unit_MVAr
-8.02396392822266
-7.93408918380737
-8.12808227535063
-8.33005142211514
-8.59836006164551
-8.7335262258584
-8.84783458709717
-8.81133937835693
-8.86044216156006
-8.88173866271973
-8.73585891723633
-8.63767713268739
-11.9456214304785
-10.7779397964478
-11.734559602356
-11.0102958675199
-10.6327905654507
-10.2672305875488

TUIDT _Unit_Current  TUI0T_Unit_Voltage

NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL

10.9862%
10.9863

10.98631
10.98631
10.98632
10.98633
1098634
10.98635
1033635
10.33636
10.38637
10.33638
10.83606
10.95437
10.91864
10.91531
10.51198
10.50865

TUID1_Unit_WinterkennedyPressure
1247375
126.265
126.0832
1286747
127.8568
125.4595
126.9487
1277219
1271146
1276265
126.1029
1251888
128.59955
128.9307
126.5245
127.8507
128.8177
125424

TUIC
9.80
985
982
5.84
9.86
9.86
9.81
9.68
9.4
9.83
9.90
9.84
9.85
9.82
9.94
993
9.89
9.86

»

=
=+
-
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Artificial Intelligence, Machine Learning,

Predictive Analytics

« Atrtificial intelligence (Al) - Ability to make decisions
through interpreting information

» Machine Learning — fancy name for data science.
Learning from data to create a relationship/algorithm.
Thinky=mx +c

* Predictive Analytics — Genesis Energy take on machine

learning focused on enhancing our maintenance
management

Requirements
» Data warehouse/historian — key

» Other data possibilities — CMMS, software diagnostics,

market data, weather

» ‘Sandbox’/platform to model data/develop algorithms
without having to code

& 0Slsoft.
. PI WOFId SAN FRANCISCO 2020

Deep leaming
Machine learning
Text generation Unstpervised

Supervised

Question answering

Natural language processing

Context extraction

Classification

Machine transiation

Expert systems

Speech to text 7
Text to speech

Image recognition

Speech

Vision
Machine vision

Planning

Robotics

https://hackernoon.com/jump-start-to-artificial-intelligence

#PIWorld ©2020 OSlsoft, LLC
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Predictive Analytics

Proactively monitoring asset health to reduce cost and increase plant reliability

.

Hard Limit

—Eypected

— A Ctual

]

Benefits/Targets

Reduced Preventative Maintenance  Reduced Defects

Moving from Calendar based to

Analytics triggered escalate.

It is not... I
- Replacing DCS/SCADA alarming i
* Real time alerting E

OSlsoft.

s PIlWorld san rrancisco 2020

Picking up on defects before they

Reduced Forced Outages
Picking up on issues before they
escalate to forced outages.

Event causing the failure The P-F
(not age related) \ r_ Interval
=E :

[ [-S——
Figure1: The P-F Curve

#PIWorld ©2020 OSlsoft, LLC
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Pl Vision - Stator Temp Last 2 Years

§ 20

L5 L L 4 L " L L " L L s L n L L L L s L L . "
01/07/2017 00:00:00 01/05/2019 00:00:00




Pl Integrator

Select Data > Modify View > Publish

) Source Assets

v [D Search Shape

=0 GEFIAF

% Asset Shape

Datanase Genesis Azsets

4 () WPS: WAIKAREMOANA POWER SCHEME

2 Assels
4 () STATIONS
» & HUNTLY
- 8 REM: RENEWAELE ENERGY
» () RENC: RENEWABLE ENERGY COMMON
» [ TEK: TEKAPO POWER SCHEME
» () TPS: TONGARIRD FOWER SCHEME
» () WAL WAIRARAPA GENERATION FACILITIES
- 8 WPS : WAIKAREMOANA POWER SCHEME
» (D KTW: KATTAWA POWER STATION
» () PRI: PIRIPAUA POWER STATION
4 ) TUI: TUAI POWER STATION
€ TUVZFQ : HYDROLOGY

» [ TUIDT :UNIT 1
» ) TUIZUNIT2
» [ TUI3:UNIT3

4 [) KTW: KAITAWA POWER STATION
# KTW Cocling Water Temperature
# KTW Cooling Water Temperature 24 hour average
# KTW Cocling Water Temperature 7 day average
4 [ PRI: PIRIPAUA POWER STATION
4 Tuai Ambient Air Temperature 24 hour moving average
# Tuzi Ambism Alr Temperature 7 day maving average
# Tuai Rainfall 24 hour average
# Tusi Rainfll 1adsy
4 () TUI: TUAI POWER STATION
4 @ TUZFQ : HYDROLOGY
# Kaitawa Laks Level
# Tuai Surge Chamber Level
# Whakamaring Lake Level
4 @ TUIOT - UNIT 1
& Turkine flow
# Unit MVA

» ) TUIS : TUAI STATION SERVICES

4 Unit MVAR output

# Unit MW output

[ # nittoral curen

# Unit voltage

Dselect Al

# Unit winter kennedy pressure.

# 15 MINUTE WARNING OF FREQUENCY CONTROL
& DRAINAGE SUMP PUMP 2 WATER LEVEL HIGH START
# FLOOD PROTECTION DC P/S

# Frequency control MW bias

# FREQUENCY CONTROL ON

# Genco courtter #1

o Genco counter #2

# Genco katawa FIR

# Genco kaitawa kv

# Genco kaitawa MVAR

# Genco kaitawa MW

# Genco keitaws rdn

# Genco keiawa rup

# Genco keitawa SR

' PIWOorld san rrancisco 2020

& Unit winter kennedy turbine flaw

4 @ TUI01/B: ELECTRICAL SYSTEMS

3

4 () TUID1/BAT - TRANSFORMER
# T1 oil H2 level
# T1 il h20 level
# T1 top cil temperature
# T1 winding temperature
4 e TUIO1/L - WATER STORAGE INTAKE AND PENSTOCKS
4 @ TUIO1/LPC : PENSTOCK SYSTEM
# Penstock pressure
4 (2 TUIOT/ME : TURBINE FLANT
4 () TUIT/MEA : TURBINE AND ASSOCIATED EQUIPMENT
4 (@ TUIO1/MEASD : BEARING ASSEMBLIES

# Bearings oil temp

- - - -

- & Tutbine bearing temp

Fx ~
,x
s
£ x
£ x
£ x
,x
R
,x
s
£ x
,x
£ x
,x
Fx
£ x
s
£ x
,x
,x
,x
s
£ x
,x
£ x
,x
R
£ x
s
£ x
,x
,x
,x
R
£ x
;S
£ x
Fd I

 Matches
Found 1 Match

» () WPS : WAIKAREMOANA POWER SCHEME

Pl Integrator makes
the data accessible
for analytics in our
tool

#PIWorld ©2020 OSlsoft, LLC
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Our In-house Tool

Pl tag:TUI02_GeneratorStator_Temperature1 with Train-MAPE:NA Forecast-MAPE:0.038 Train-RSquare:0.759 and Forecast-RSquare:(.85

Ability to select
input variables,
remove unrelated
data (eg plant in
=« oOutage), training
~™  periods and
forecasting check
to validate model

207407 2018 20807 2080

/ OSlsoft.

' PIWorId SAN FRANCISCO 2020 #PIWorld  ©2020 OSlsoft, LLC
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Generator Stator Temperature

Legend
—+— Actual
—— Alert

404

OSlsoft.

. PI WOFICI SAN FRANCISCO 2020

—— Forecast

This shows an
example of a
training period
(blue), forecasted

period (orange) with

a good model fit
(3.8% error)

#PI1World

©2020 OSlsoft, LLC
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Generator Stator Temperature — With Model

Pl tag:TUI02_GeneratorStator_Temperature1 with Forecast MAPE = 0.064 and RSquare = 0.622

20

This is the start of
the divergence of
the actual
temperature to the
model.

Legend
—— Actual

~#=_ They both start out
in sync then the
actual temperature
starts to rise.

401

0OSlsoft.
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Generator Stator Temperature — With Model

Pl tag:TUI02_GeneratorStator_Temperature1 with Forecast MAPE = 0.064 and RSquare = 0.622

01

Here the issue was
resolved. There was
a particularly
blocked air filter

- which meant

~ws cooling was limited.

—= Alert

B0

— Forecast

Post repair you can
see the model and
actual match well
again

407

Apr I3 May 06

“Y OSlsoft.
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Turbine Bearing Temperature

Pl tag:TKUO3_TurbineBearing_Temperature1 with Forecast MAPE = 0.078 and RSquare = 0.06

TR

Second example
monitoring bearing
temperatures. This
particular one is
modelling

. temperature relative

~ e to the other
bearings

Apr 2013 Jul 2019 Oct 2018 Jan 2020

OSlsoft.
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g

Turbine Bearing Temperature

1|l onsidering MW

Pl tag:TKU03_TurbineBearing_Temperature2 with Forecast MAPE = 0.047 and RSquare = 0.054

i | This models based

¢ Ikl Rt o |."¢_“l | i’i1||'|||i|f.- Jlﬂ"“i il Ml‘

&'"‘“f il 1) =
| i il il on machine output
N H | and ambient
conditions.

—= Alert

- =« Bearing was
repaired end of
2019, avoided 2
week outage
extension and
recasting

Legend
‘ —— Actusl

Apr 2013 Jul 2018 Oct 2018 Jan 2020

OSlsoft.
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How to M

anage Multiple Models — Power Bl

MARC

that have been createa in the MARC machine leaming t

25/05/2019

20/06/2019

@8

388

20/06/2019 3:30:00 am

<

Alarm Multiplier Model DESCRIPTION ML Model Error Online MAPE  Online MAPE  Online MAPE  Online MAPE  Online MAPE A
L Method -1D -3D -1w 2w -1M
17 KTWOG_BAT_TransformerQilTemp_fromMWandambienttemp RF-30 145% 15.9% 16.5% 152% 19.3% 20.4%
Station O KTWOG_BAT TransformerWindingTemp_FromMWandambientTemp RF-30 14.9% 14.0% 14.3% 13.5% 16.7% 17.4%
KTW KTWO6_ME_TurbineBearing_VibrationCalibration RF-30 8.5% 6.5% 8.0% B.8% 9.2% 9.5%
PRI KTW06_ME_TurbineBearing_XVibrationfromMW RF-30 75% 5.9% T7.0% 84% 8.5% 87%
RPO Equipment KTWO6_ME_TurbineBearing_YVibrationfromMW RF-20 11.9% 5.5% 7% 0.6% 10.73% 11.5%
TKA BAC KTWO6_ME_TurbineBearing_YVibraticnfromotherbearings RF-30 9.5% 73% 7.6% 83% 9.0% 10.2%
TKB BAT KTW06_ME_TurbingBearing_XVibrationfromotherbearings RF-30 8.0% 7% 9.7% 9.6% 10.8%
TKU ME KTW06_MK_GeneratorStator_Temp 1from2 LM-2 05% 0.4% 04% 0.5%
KTWO6_MK_GeneratorStator_Temp 1fromMWandStatorcoolairtemp RF-30 38% 1.1% 3.0% 34%
Tul MK, KTW06_MK_GeneratorStator_Temp3from4 LM-2 04% 04% 04% 05%
Unit KTW06_MK_GeneratorStator_Temp3fromMWandstatorcoolairtemp RF-30 37% 12% 33% 34%
KTWO06_MK_GeneratorStator Temp5fromé L-2 1.5% 0.6% 0.8% 1.0%
Plant KTWOE_MK_GeneratorStator_TempSfromMWandStatorcoolairtemp RF-30 3.6% 1.0% 3% 34%
KTWO86 KTWO06_MK_GeneratorStator_WarmairTempfromCoolairtempandMW RF-20 21% 0,?% 15% 14%
KTWO7 KTW06_MEK_LowerGuideBearing_Tempfromotherbearings RF-50 23% 6% 63% 5.5%
PRIO4 KTWOB_MK_LowerGuideBearing_VibrationCalibration LM-3 6.1% 194%
PRIOS KTWO0B_MK_LowerGuideBearing_XVibrationfromotherbearings RF-30 79% 223%
RPOOS KTWO6E_MK_ThrustBearing_Temp lfromatherbearings RF-50 17% & 5% %
KTWO6_MEK_ThrustBearing_Tempcalibration LM-3 13% 02% 0.5% 07% 0.8% 0.7%
RDMNNA
Input Tagsz | Day | KTW_CooclingWater_Temperature | KTW_CoolingWater_Temperature_24Hourlverage l KTW_CaooclingWaterTemperature ] KTWO06_Generatar_CoolAirTemperature | KTW06_GeneratarStator_Temperature2 | KTwoi

0OSilsoft.

Online Only Notify ;2
@Orline Only Alert §
@ Onlinz Cnly Actual u_z 10K
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Generator temperature example from before

M ﬂ RC 1/01/2019  10/05/2019 10/05/2019 3.00.00 am.
: : 1
Alarm Multiplier Model DESCRIPTICN ML Model Eror  Online MAPE  Online MAPE  Cnline MAPE  Online MAPE  Online MAPE
Methad -1 -2D 1w 2w 1M
20 =
Station O
W
Equipment
BAT
ME
MK : . -
TUI02_MK_GeneratorStator_Temperature ] framMW, MVAR AmbientTemperature M-3 3.4% 08% 34% 3.8% 129% [
Plant
TUIOT
M Tuio2
TUIO3
Input Tags: TUI PowerStation_Temperature | TUIOZ_Unit_MVA | TUIDZ_Unit MW s play
| On ll Off I
80
L
Z 6 i L | i Online Only Notify
% ﬁ"ﬂ'h | 'Hu‘\“] J\
= AW W\f] HJJ]‘ 1‘\{ W V'k @Online Only Alert
B N 1 \
g 40 @ Online Only Actual
E @ Qnline Only Forecast
]
= oMW
OSlsoft. Feb 2019 Mar 2019 Apr2019 May 2019
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How to we track benefits?

63

2 19 38

4

Total benefits:

$

O,

All issues To validate Closed Cancelled
Search... Location Sort by | TicketNumber Descending WA
To validate Issue # 69 3% increase on pad 2 temp following outage Reported date: 17/02/2020
open PRIO5_ThrustBearing_TemperaturePad2 >
low priority Thrust bearing pad 2 temp increased after annual outage. Temperature rise still looks normal
Open and possibly due to probe arrangement in PRI thrust bearings. Will continue to monitor to see
Issue # 64 Turbine Y vibration dropped down Reported date: 15/01/2020
Closed open TUIO1 TurbineBearing_YVibration 5
low prioxity y vibration readings dropped quite low on about 20th December. Discussed with Kobus,
Cancelled follow up with site (Neal) to see if they modified draft tube vacuum vales.
Issue # 63 Need to build Sync Con models Reported date: 14/01/2020
All open TKUO1_TurbineBearing_XVibration >
low priority TKUO1 is running alot recently on Synchronis condensing, this does not fit our existing
models.
Issue # 61 Turbine Bearing hotter than expected Reported date: 18/12/2019
{J| open TKUO2_TurbineBearing_TemperaturePad2 >
medium priority  Tokaanu G2 turbine bearing hotter than expected. TA not concerned as the temp is similar to
other units
Issue # 60 Vibration step change Reported date: 17/12/2019
open TKUO2_TurbineBearing_XVibration >

medium priority

Issue # 58
open
low priority

Issue # 56

open

Turbine bearing x vibration has a step change around 1st December 2019. Needs further
investigation. Looks like Y vibration doesn't change as significant.

TKBO3_TurbineBearing_TemperaturePadA

Turbine Bearing Pad A and B have step changes in temps e.g. 5th December at 11:30pm. .
This appears to happen when there is a change over of pumps, however this doesn't seem to

RPO05_LowerGuideBearing_YVibration

Reported date

Reported date

1 13/12/2019

1 12/12/2019

v

Have a register to
track issues. Assign
priorities, actions,
dates etc.

Benefits calculated
from resulting
failure considering
likelihood of
becoming genuine
issue, likelihood it
could have been
detected prior

#PIWorld ©2020 OSlsoft, LLC
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Achievements so far

From Feb 2019 developed over 800 models on thermal and hydro plant
Developed with 50% FTE and predominately internal resource costs

Have used open source software and low code solutions

50+ validated issues identified

Proven savings and avoided outages
Good engineering buy in for ones that have been involved with an issue
Have a large backlog of potential models still to create

& OSlsoft. _
' PIWorld sanrrancisco 2020

#PI1World
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Going Forward

» Better visual representation of models’ performance (digital
twins anyone?)

* More modelling potential; transient operations (starts and
stops), long term forecasting

 Building the business process on how to manage Model
‘alerts’ and cultural engagement

» Confidence that modelling can replace time based
maintenance

* Install more sensors to capture data and fill current
data/modelling gaps

& OSlsoft. _
' PIWorld sanrrancisco 2020

Transformer Cooler

Transformer

#PI1World
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 Michael Eschenbruch

» Senior Asset Management and Modelling
Engineer

* Genesis Energy
 Michael . Eschenbruch@genesisenergy.co.nz
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